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Welcome to KPT effects

procreate™ presents KPT® effects™, the next generation of the revolutionary
KPT series of filters designed to help you create dazzling and unique effects.

In this section, you'll learn about
+ KPT effects filters
+ KPT effects Help

+ KPT effects tutorials
+ procreate

+ support and services
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KPT effects

The KPT effects filters are KPT® Channel Surfing™, KPT® Fluid™, KPT®
FraxFlame II™, KPT® Gradient Lab™, KPT® Hyper Tiling™, KPT® Ink
Dropper™, KPT® Lightning, KPT® Pyramid Paint™, and KPT® Scatter™.

KPT Channel Surfing

The KPT Channel Surfing filter lets you apply effects to individual channels in an
image. You can blur or sharpen a channel, or you can adjust its contrast or value.
You can adjust the amount and transparency of the effect and control how the
effect blends with the source image.

KPT Fluid

The KPT Fluid filter lets you manipulate images by applying liquid-like
transformations and distortions that simulate dragging a brush across a wet
surface. You can control the effect by setting the thickness of the fluid as well as
the brush size and velocity. You can use various preview techniques to fine-tune
the effect, and choose to save the fluid in motion as a movie.

KPT FraxFlame Il

The KPT FraxFlame Il filter lets you explore and mutate an infinite variety of
flame fractals. You can also customize fractals with various color, contrast, and
distortion techniques.
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KPT Gradient Lab

The KPT Gradient Lab filter lets you create complex color blends with various
levels of transparency. You can also customize gradients with interesting shapes,
styles, and pixel distortions.

KPT Hyper Tiling

The KPT Hyper Tiling filter lets you create and save intricate tiling effects by
reducing a source image to create a tile. The tile is then repeated to create a
hypertiling effect. You can create different blends between the source image and
the effect, and you can change the viewer’s perceived distance from the effect.
You can also change the depth, transparency, position, and size of the effect, and
you can rotate it through space.

KPT Ink Dropper

The KPT Ink Dropper filter lets you create the effect of dropping colored liquid
(ink) on a surface. You can create fluid drops, stains, and smoky swirls. You can
choose the color of the liquid, and change its intensity and transparency. You can
also change the size of the individual drops, and the rate at which they disperse
on the surface.

KPT Lightning

The KPT Lightning filter lets you create customized lightning bolts. You can
control every aspect of a lightning bolt, from setting its length and color, to
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determining its path and how much it zags and wanders. The lightning effect can
then be realistically integrated into your source image using one of several blend
modes.

KPT Pyramid Paint

The KPT Pyramid Paint filter uses the Lab color mode to let you transform source
images into effects that resemble paintings and perform various color and
contrast adjustments to them.

KPT Scatter

The KPT Scatter filter lets you disperse particles over a source image. You can
disperse a single particle or a grid of particles over an effect to emulate intricate
effects such as paint strokes or mosaics. You can also use variants to create
special effects based on the way particles interact with different components of a
source image. You can control every aspect of particle placement, color, and
shadow.

About KPT effects Help

The KPT effects Help assumes you are already familiar with basic Mac® OS and
Windows® concepts — menus, dialog boxes, and mouse operations, such as
clicking and dragging. If you need more information on these subjects, or about
the Apple® Finder™ or the Windows desktop, refer to the Mac® OS User Manual
or the Microsoft® Windows® User Guide, respectively.
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KPT effects Help conventions

The KPT effects Help is for both Mac OS and Windows platforms. By convention,
Mac OS commands precede Windows commands in the text. For example,
Command/Ctrl + 1, is equivalent to the Mac OS Command + | and the Windows
Ctrl + 1, and indicates that you must hold down the Command or Ctrl key, and
press I. For simplicity, the term “folder” refers to directories as well as folders.
The KPT effects interface for Mac OS and Windows platforms is identical.

KPT effects tutorials

The KPT effects tutorials introduce you to KPT effects and help you become
productive quickly.

To access the tutorials, click here.

The KPT effects tutorials page is updated regularly, and new tutorials are added
as we create them.

About procreate

procreate is a new line of software expressly designed to extend the possibilities
of creative professionals. It defines a new category of products that add
enhanced capabilities to the user’s collection of tools. With procreate, creative
professionals can bring their most ambitious ideas to life. Featuring KnockOut 2,
KPT effects and Painter 7™, procreate makes the impossible possible.


http://product.procreate.com/app/kpt/7/tutorials/KPTE_servermain.htm
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Learn more. Visit www.procreate.com.

Support and services

We are committed to providing quality customer service and support that is easy
to access and convenient to use, while fostering one-to-one customer
relationships. If you have a question about the features and functions of our
applications or operating systems, see the user guide or Help for the product you
are using. Updates and technical information are also available in the Release
Notes.

Registering products

Registering products is important. Registration provides you with timely access to
the latest product updates, valuable information about product releases and
access to free downloads, articles, tips and tricks, and special offers.

For more information about registering a product, see the Help for the product or
see http://www.corel.com/support/register on the Internet.

Technical support

The Web address for Corel is http:/www.corel.com on the Internet. A list of
localized Corel Web sites is available at

http:/www.corel.com/international on the Internet.


http://www3.corel.com/cgi-bin/gx.cgi/AppLogic+FTContentServer?pagename=Corel/International/Index
http://www.corel.com/support/register
http://www.procreate.com
http://www.corel.com
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Self-serve technical support options

Several self-serve tools are available to address technical questions 24 hours a
day, seven days a week.

Support newsgroups

http://www.corel.com/support/newsgroup.htm

Knowledge base
http://kb.corel.com

FAQs
http://www.corel.com/support/faq
File Transfer Protocol (FTP)
ftp://ftp.corel.com

FTP information

http://lwww.corel.com/support/downloads/index.htm

Automated Fax on Demand*
1-877-422-6735

*Fax on Demand is available only in North America.


http://www.corel.com/support/downloads/index.htm
ftp://ftp.corel.com
http://www.corel.com/support/faq
http://kb.corel.com
http://www.corel.com/support/newsgroup.htm
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Telephone technical support options

Users can use complimentary and fee-based telephone technical support
options. Three levels of support are available.

Classic Service

Classic Service is a complimentary, 30-day service designed to address
installation, configuration, and new feature issues. This service begins on the day
of your first technical support call.

Classic Service is a paid for service for OEM, “White box,” Jewel Case (CD only),
trial, or Academic versions of products.

Priority Service

Priority Service is a fee-based service for users who require the help of
second-level technicians. Priority Service may be purchased by the minute, by
the incident, or on a term basis. Options range from core-business-hour access
for individual users to around-the-clock access for multiuser environments.

Premium Service

Premium Service is the highest level of support. This service is designed for
organizations that want to establish a direct relationship with Corel and for
organizations that employ dedicated support professionals or have centralized
technical management.

10
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Customer Service

Customer Service can provide you with prompt and accurate information about
product features, specifications, pricing, availability, and services. Customer
Service does not provide technical support. You can access Customer Service
support through the following avenues.

World Wide Web
You can access general customer service and product information at

http://www.procreate.com on the Internet.

Mail, fax, email

You can send specific customer-service questions to Customer Service
representatives by mail, fax, and email.

Corel Corporation

Corel Customer Service
1600 Carling Avenue
Ottawa, Ontario
Canada K1Z 8R7

Fax: 1-613-761-9176

Email: custserv2@corel.ca

11
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Telephone
You can telephone Customer Service centers with your questions.

In North America, you can reach Customer Service by calling the
1-800-772-6735 toll-free line.

The hours of operation are 9:00 a.m. to 9:00 p.m., eastern time (ET), Monday
through Friday, and 10:00 a.m. to 7:00 p.m. on Saturdays.

Corel customers outside North America can call a local authorized Corel
Customer Service Partner.

12
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Getting started with KPT effects

KPT effects is an extraordinary collection of filters that produce dazzling and
unique effects for print and the Web. Whether you are a professional designer,
artist, Web author, or hobbyist, the KPT effects filters will help you take your work
to a new creative level, and enhance your productivity.

In this section, you'll learn about

+ installing KPT effects

+ accessing and quitting KPT effects filters
+ the workspace

+ using panels and sliders

+ previewing filter effects

+ customizing the workspace

+ storing workspace and panel settings

+ working with presets

13
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Installing KPT effects

You can install KPT effects in host applications compatible with Mac OS and
Windows.

To install KPT effects in Mac OS

1 Insert the KPT effects CD into the computer’s CD drive.

2 Browse to the KPT effects folder.

3 Double-click the KPT effects installer icon.

4 Follow the instructions on your screen.

To install KPT effects in Windows
1 Insert the KPT effects CD into the computer’s CD drive.
2 Click Install.

3 Follow the instructions on your screen.

Accessing and quitting KPT effects filters

You can access a KPT effects filter from the host application. You can quit a KPT
effects filter in two ways. You can quit a filter and apply the effect to the source
image in the host application. You can also quit a filter without applying the effect
to the source image in the host application.

14
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To access a filter
+ Do one of the following:
+ In Adobe® Photoshop®, click Filters » KPT effects, and click a filter.
+ |n Painter 7™, click Effects » KPT effects, and click a filter.
+ In Corel PHOTO-PAINT®10, click Effects » KPT effects, and click a filter.

+ In Bryce®, click a flyout arrow in the Pictures dialog box in Picture editor,
click KPT effects, and click a filter.

w If you want to access a KPT effects filter in Bryce for the first time, you
must first click a flyout arrow in the Pictures dialog box, click Select
plug-ins folder, choose the folder where KPT effects is installed, and
click Choose/OK.

To quit a filter

+ Click one of the following buttons:
+ OK —to quit a filter and apply the effect

+ Cancel — to quit a filter without applying the effect

15
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Exploring the workspace
The KPT effects workspace contains a Preview window and a set of controls.

Help button

KPT logo wr i Lk Web button

Filter nameJ
Filter-specific
panels <

Presets button—#& l

Preview window

28— OK button

Recall panel Layout panel Cancel button

16
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The following table provides a description of each common control in the KPT
effects workspace, starting with the Preview window.

Control name Description

Preview window Lets you preview the effects you
create. For more information about
setting preview options, see
“Previewing filter effects.”

KPT logo Lets you customize the display of the
KPT workspace, and access product
information

Filter name Lets you customize the display of

panels. For more information about
setting panel display options, see
“Using panels and sliders.”

Web button Lets you connect to the procreate
Web site where you can access
information about KPT effects and
other procreate products

17
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Control name

Getting started with KPT effects

Description

Help button

Layout panel

Recall panel

Presets button

Cancel button

OK button

Lets you access the KPT effects Help

Lets you store workspace layout
settings. For more information about
using the Layout panel, see “Storing
workspace and panel settings.”

Lets you store panel settings. For
information about using the Recall
panel, see “Storing workspace and
panel settings.”

Lets you load and store presets. For
more information about using presets,
see “Working with presets.”

Returns to the host application without
applying the effect to the source
image

Returns to the host application and
applies the effect to the source image

18
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Using panels and sliders

You can set the style in which panels display. You can also move sliders.

To set a panel display style
1 Click the filter name.
2 From the Filter options list box, choose one of the following styles:
+ Panel auto popup — to automatically expand panels as you move the
pointer over them
+ Panel manual popup — to manually expand panels by clicking the Cycler
button in the title bar
+ Panel solo mode — to expand the current panel and automatically collapse
those not in use

%f? In Panel auto popup mode, sliders expand to display a panel with
additional controls you can use to adjust slider settings incrementally,
and view previous slider settings (indicated by the location of the gray
arrow).

19
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@6 In Panel manual popup mode, you can expand a panel by clicking the
Cycler button in the right corner of its title bar.

In Panel solo mode, you can collapse an expanded panel by
double-clicking its title bar.

To move a slider

+ Drag the black slider arrow.

Previewing filter effects

The Preview window lets you dynamically view the results of your work. You can
apply a background to the Preview window. You can also move and size the
Preview window.

To apply a background to the Preview window
+ Click the flyout arrow in the Preview window, and choose one of the following
options from the Preview options list box:

+ Preview against black — to display an effect against a solid black
background

+ Preview against white — to display an effect against a solid white
background

+ Preview against checkerboard — to display an effect against a
background of gray squares

20
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+ Preview against dark checkerboard — to display an effect against a
background of dark gray squares

+ Preview against gradient — to display an effect against a grayscale
gradient background

7
w The effect only displays against the background while it is in the
Preview window. The background is not applied to the source image in
the host application, and does not impact the final render of the effect.

To move the Preview window

+ Drag the title bar.

To size the Preview window
1 Click the flyout arrow in the Preview window.

2 From the Preview options list box, choose one of the following Preview
window sizes:

+ Small preview
+ Medium preview

+ Large preview

21
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Customizing the workspace

You can apply a fun icon style to the common workspace. If the KPT workspace
is smaller than the resolution of your screen, you can also display or hide
common workspace controls.

To apply a fun icon style to the common workspace

1 Click the KPT logo.

2 Choose Smileys! from the Global options list box.

To display or hide common workspace controls
1 Click the KPT logo.

2 Choose Black out screen from the Global options list box.

Storing workspace and panel settings

Storing workspace settings lets you save different workspace layouts. For
example, you can arrange all panels on one side of the workspace and enlarge
the Preview window, and then save this layout for later use.

Storing panel settings lets you save and compare different versions of a filter
effect.

The workspace and panel settings you save are retained from one session to
another, so you can use them again and again. When you no longer need stored

22
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workspace and panel settings, you can clear them. You can also restore default
workspace or panel settings.

To store workspace settings
+ Click a gray memory dot in the Layout panel.

w Empty memory dots display gray, full memory dots display green, and
memory dots currently in use display yellow.

To store panel settings
+ Click a gray memory dot in the Recall panel.
To use stored workspace or panel settings

+ Click a green memory dot in one of the following panels:
+ Layout — to use stored workspace settings

+ Recall — to use stored panel settings
To clear stored workspace or panel settings

+ Hold down Option/Alt, and click the corresponding green memory dot in one
of the following panels:
+ Layout — to clear stored workspace settings

+ Recall — to clear stored panel settings

23
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To restore default workspace or panel settings

+ Click the memory dot in the center of one of the following panels:
+ Layout — to restore default workspace settings

+ Recall — to restore default panel settings

Working with presets

Some KPT effects filters provide you with preset effects. You can load a preset
effect. You can also save an effect you create as a preset. You can create
multiple presets categories in which to organize the presets you store.

You can import and export presets.

To load a preset
1 Click the Presets button.

2 Double-click a preset thumbnail in the Presets library panel.

If the preset is stored in a category, you must first choose the category from
the middle-left tile of the Presets library panel, then double-click a preset
thumbnail.

Q¢ You can preview a preset by single-clicking a preset thumbnail. A larger
version of the preset thumbnail displays in the upper-left tile of the
Presets library panel.

24
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To save an effect as a preset
1 Click the Presets button.
2 Choose a category from the middle-left tile of the Presets library panel.

3 Click Add preset.
A preset thumbnail displays in the Presets library panel.

@¢ You can also delete a preset from a category by clicking a preset
thumbnail, and clicking Delete preset.

To create a presets category
1 Click the Presets button.

2 Click the flyout arrow in the Presets library panel, and click Create new
category.
A text box displays in the middle-left tile of the Presets library panel.

3 Type a name.

4 Press Return/Enter.

N7,
5} Each category can store up to 24 presets.

25
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To import a preset

1
2

Click the Presets button.

Click Import in the Presets library panel.

If you want to import a preset to a specific category, you must first choose the
category from the middle-left tile of the Presets library panel, and then click
Import.

3 Choose the folder where the file is stored in the From dialog box.

Click the file.

5 Click Open.

The preset displays as a thumbnail in the Presets library panel.

To export a preset

N o o0~ WN P

Click the Presets button.

Choose a category from the middle-left tile of the Presets library panel.
Click a preset thumbnail.

Click Export.

In the Save as dialog box, type a filename in the Save as box.

In the Where box, choose the folder where you want to export the file.
Click Save.

26
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Using KPT Gradient Lab

Using KPT Gradient Lab

The KPT Gradient Lab filter lets you create complex, multi-layered gradients with
interesting shapes and styles. You can also control the color, contrast, and
orientation of gradients you create.

In

*

*

*

this section, you'll learn about
exploring the workspace
defining a work area

working with color and contrast
distorting gradients

changing gradient orientation
mirroring gradients

layering gradients

blending gradients

applying styles to gradients

viewing gradients from different perspectives

27
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Exploring the workspace

The KPT Gradient Lab workspace contains a Preview window and a set of
panels and controls.

Gradient Lab Help button

KPT logo

£ 8 —Web button

Preview window
Settings panel ——

Layers panel

Presets button—— & ??

Cancel button OK button

Recall panel  Layout panel

28
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Using KPT Gradient Lab

The following table provides a description of each control in KPT Gradient Lab,
starting with the filter-specific panels.

Control

Description

Settings panel

Layers panel

Gradient panel

Preview window

KPT logo

Lets you apply a style or blend to a gradient. You can
also change the orientation, frequency, and opacity of
a gradient.

Lets you add, delete, and stack layers in a gradient

Lets you define a work area in a gradient, and apply a
color, shade of gray, or level of transparency. You can
also adjust the intensity, contrast, and transition of
colors in a gradient.

Lets you preview the effects you create. For more
information about setting preview options, see
“Previewing filter effects.”

Lets you customize the display of the KPT workspace,
and access product information

29
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Gradient Lab

procreate button

Help button

Layout panel

Recall panel

Presets button

Using KPT Gradient Lab

Lets you customize the display of the Settings,
Layers, and Gradient panels. For more information
about setting panel display options, see “Using
panels and sliders.”

Lets you connect to the procreate Web site where
you can access information about KPT effects and
other procreate products

Lets you access the KPT effects Help

Lets you store workspace layout settings. For more
information about using the Layout panel, see
“Storing workspace and panel settings.”

Lets you store different settings of the Settings,
Layers, and Gradient panels. For information about
using the Recall panel, see “Storing workspace and
panel settings.”

Lets you store presets. For more information about
using presets, see “Working with presets.”

30
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Cancel button Returns to the host application without applying the
effect to the source image

OK button Returns to the host application and applies the effect
to the source image

Defining a work area

By default, effects that you apply encompass the entire gradient, and are not
isolated to a specific section unless you define a work area. You can define a
work area by sizing the bracket located directly above the combination palette.
You can move or pivot the work area. You can also reset the work area.

To define a work area

+ In the Gradient panel, drag an edge of the bracket left or right.

You can also

Move the work area Click the bracket, and drag left or
right.
Pivot the work area Drag one edge of the bracket past the

opposite edge.

31
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Reset the work area Double-click the bracket.

02 ) . .

5/ You cannot apply effects to areas of a gradient that are not contained in
the bracket. If you want to apply effects to another area of a gradient,
you must move the work area.

Working with color and contrast
You can apply a color, shade of gray, or level of transparency to a gradient.

You can adjust the intensity of colors in a gradient by modifying the hue,
saturation, and brightness. Hue represents the pigment of a color and is
measured in degrees. Saturation describes the vividness or dullness of a color
and is measured in percent from 0 to 100 (the higher the percentage, the more
vivid the color). Brightness describes the amount of white contained in a color
and is measured in percent from 0 to 100 (the higher the percentage, the brighter
the color).

You can adjust the contrast of colors in a gradient. By adjusting the contrast, the
differences in the color values of neighboring light and dark pixels is adjusted.

You can adjust the transition from one color to another. You can sample color
from a gradient.

32
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To apply a color or shade of gray

1 Inthe Gradient panel, click and hold down the pointer on the Combination
palette.

2 Drag the pointer over one of the following:
+ Color bar — to apply a color
+ Grayscale bar — to apply a shade of gray
3 Release the pointer on the preferred color or shade of gray.
k’f} When you click the Combination palette, three bars display. The top
bar is the Grayscale bar, which lets you apply a shade of gray from
black to white. The middle bar is the Color bar, which lets you apply a
color from a spectrum of colors and shades. The lower bar is the

Opacity bar, which lets you adjust the transparency through which the
source image can display. For more information about adjusting the

33
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transparency of a gradient, see “To adjust the transparency of a
gradient.”

Where you click on the Combination palette determines where the
effect will display in the gradient. For example, clicking on the far left
side of the Combination palette lets you apply the effect to the far left
side of the gradient. Similarly, clicking on the far right side of the
Combination palette lets you apply the effect to the far right side of the
gradient.

To adjust the transparency of a gradient

1 Inthe Gradient panel, click and hold down the pointer on the Combination
palette.

2 Drag the pointer over the Opacity bar.
3 Release the pointer on the preferred transparency.
K*}A When you adjust the transparency of a gradient, you change the
grayscale values of its individual pixels. Grayscale values range from
black (a transparent value of 0), to white (an opaque value of 255).
To adjust the color intensity of a gradient
1 Inthe Gradient panel, click one of the following:
+ Hue — to rotate hues

+ Saturation — to modify the intensity of colors
34
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+ Brightness — to modify the brightness of colors

2 In the expanded panel, move the black slider arrow.

N\ . . .

5/ When you rotate the hue in a gradient, you cycle through all colors in the
spectrum, but maintain the relative distance, in pixels, between each
color.

To adjust the color contrast
1 Click Contrast in the Gradient panel.

2 Move the black slider arrow in the expanded Contrast panel.

N2z , ; i
5/ If you increase the contrast, the difference between colors is
exaggerated. If you decrease the contrast, the colors are homogenized.

Q\‘ You can decrease the contrast to the point where the gradient displays
in a shade of gray.

To adjust gradient color transition

1 Click the Transition slider in the Gradient panel.

A triangle displays in the color located directly above, in the Combination
palette.

2 Move the triangle left or right.

35
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k’f} The Transition slider displays below the Combination palette.

You can create as many triangle sliders as required to adjust the
gradient color transition.

Q¢ You can remove a triangle from the Transition slider by holding down
Option/Alt, and clicking a triangle.

To sample color
1 Inthe Preview window, click one of the following buttons:
+ Linear sample — to sample color from along a straight path
+ Circular sample — to sample color from within a circular area

2 Drag across the color you want to sample.

N7,

E/}A The sample begins where you click in the Preview window, and ends
where you release, at the end of the drag. The sample displays in the
Combination palette.

36
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A Linear sample

by
) 'l

A Circular sample

Distorting gradients

You can feather or blur a gradient. Feathering softens the edges of pixels by
gradually increasing their transparency. Blurring smudges the edges of pixels by
gradually blending them together.

37
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You can squeeze a gradient. You can also repeat a gradient, increasing its
frequency multiple times.
To feather a gradient

+ Click the flyout arrow in the Gradient panel, and click Feathering.

To blur a gradient
1 Click Blur in the Gradient panel.

2 Move the black slider arrow in the expanded Blur panel.

@y
Dragging up increases the blur; dragging down decreases the blur.

A blurred gradient

38
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To squeeze a gradient
1 Click Squeeze in the Gradient panel.
2 Move the black slider arrow in the expanded Squeeze panel.

%”’? If you have defined a work area, the squeeze starts at the center of the
bracket and moves to the end.

For more information about defining a work area, see “Defining a work
area.”

Q\‘ If you want to start a squeeze from a point other than the center of the
bracket, you must hold down Option/Alt, and drag in the Combination
palette.

A squeezed gradient

39



K & Bl Using KPT Gradient Lab
To repeat a gradient

1 Click Frequency in the Gradient panel.

2 Move the black slider arrow in the expanded Frequency panel.

%/ You can repeat a gradient multiple times.

e ' e I'm v} |

A repeated gradient

Changing gradient orientation
You can flip, rotate, or change the angle of a gradient.

To flip a gradient

+ Click the flyout arrow in the Gradient panel, and click Flip gradient.

40
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To rotate a gradient
1 Click Cycle in the Gradient panel.

2 Move the black slider arrow in the expanded Cycle panel.

A rotated gradient

To change the angle of a gradient

+ Move the Angle slider in the Settings panel.

w If you have applied a circular, elliptical, radial, rectangular, or squared
style to a gradient that you have angled, you can view it from different
perspectives. For more information, see “Viewing gradients from
different perspectives.”

41
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Two examples of angles at which you can position a
gradient

Mirroring gradients
You mirror a gradient from:

+ left to right

+ right to left

+ left to right, and back to left

+ right to left, and back to right.

To mirror a gradient
1 In the Settings panel, click the flyout arrow in the Mirroring area.
2 From the Mirroring list box, choose one of the following settings:

+ Ato B —to set a left to right transition

42
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+ B to A —to set aright to left transition
+ Ato B to A —to set a left to right to left transition

+ Bto Ato B —to set aright to left to right transition

Layering gradients

You can add multiple layers to a gradient. You can display each layer individually,
so that you can apply effects. The layer you display is called the active layer. You
can move a layer toward the surface or the foundation of a gradient. You can also
delete a layer.

To add a layer to a gradient

+ Click the Add button in the Layers panel.

To display a gradient layer

1 Click a layer in the Layers panel.

2 Click the Up arrow until the layer displays in the Preview window.

w If the gradient layer you display has a squared or rectangular style
applied to it, you can view it from different perspectives using the X,Y
button in the Preview window. For more information about viewing
gradients from different perspectives, see “Viewing gradients from
different perspectives.”
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As you move between layers, the active layer changes, and dynamically
displays in the Combination palette.

For more information about applying styles to gradients, see “Applying
styles to gradients.”

To delete a layer from a gradient
1 Click a layer in the Layers panel.
2 Click the Trash button.

77
%}A If there is only one layer in the Layers panel, it cannot be deleted.

Blending gradients
You can apply one of the following blend modes to a gradient.

Example Description

The Add blend mode adds the values

w of the effect and the source image.
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Description

The Blend blend mode averages the
pixel, alpha, and channel values of
the effect and source image. You can
use the Opacity slider to adjust the
transparency of the effect.

The Blend into blend mode blends
the RGB channels of all layers of the
effect, except the bottom layer. This
blend mode does not alter the alpha
channels of the effect.

The Darken blend mode compares,
pixel by pixel, the combined RGB
values of the source image and the
effect, and uses the darker pixels of
the two. The result is a darker image.
This is the inverse of the Lighten
blend mode.
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Example Description

The Difference blend mode inverts

the color values of the source image
based on the luminance (brightness)
values of the effect pixels. The black

areas of the effect, which have no
luminance, do not change the source
image; while the white areas of the
effect cause the source image pixels
to be inverted. Where the effect has
both black and white color values, the
source image is inverted only partially.
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Description

The Difference 2 blend mode inverts
the color values of the effect based on
the luminance (brightness) values of
the source image pixels. The black
areas of the source image, which
have no luminance, do not change the
effect; while the white areas of the
source image cause the effect pixels
to be inverted. Where the source
image has both black and white color
values, the effect is inverted only
partially.
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Description

The Lighten blend mode compares,
pixel by pixel, the combined RGB
values of the source image and the
effect. If a source image pixel is
lighter than the corresponding effect
pixel, the source image pixel is used.
If a source image pixel is darker than
its corresponding effect pixel, the
effect pixel is used. The result is a
lighter image.

The Multiply blend mode applies only
the darker areas of an effect to the
source image. This blend mode is
useful for adding shadows to an
image.
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Description

The Normal blend mode blends the
transparency and color values of the
effect and the source image.

The Procedural blend mode
combines the effect with the source
image based on the luminance
(brightness) value of each individual
pixel in the source image. The effect
is applied on top of the source image
pixels that have the median
luminance value of 128 (out of 256).
Where source image pixels are
brighter then the median value, the
effect brightens. Conversely, where
source pixels are darker than the
median value, the effect darkens.
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Description

The Replace hue blend mode
replaces the hue values of the source
image with the corresponding hue
values of the effect.

The Replace luminance blend mode
replaces the brightness values of the
source image with the corresponding
brightness values of the effect.

The Replace saturation blend mode
replaces the saturation values of the
source image with the corresponding
saturation values of the effect.
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Description

The Reverse blend mode combines
the effect with the source image
based on the luminance (brightness)
value of each individual pixel in the
source image. The effect darkens
where source image pixels are
brighter than the median value of 128
(out of 256), and brightens where
source image pixels are darker than
the median value. This is the inverse
of the Procedural blend mode.

The Screen blend mode applies only
the lighter areas of the effect to the
source image. This mode is the
inverse of the Multiply blend mode.
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Example Description

The Similarity blend mode inverts the
i color values of the source image
' pixels based on the luminance
(brightness) values of the effect
pixels. The black areas of the effect,
which have no luminance, cause the
source image pixels to be inverted;
while the white areas of the effect do
not affect the source image. Where
the effect has both black and white
color values, the source image is

inverted only partially. This is the
inverse of the Difference blend mode.
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Example Description

The Subtract blend mode adds the
values of the effect and the source
image and subtracts 255 from the
result. This blend mode treats the
color channels as subtractive, so the
result is never lighter than the source

image.

To apply a blend

+ In the Settings panel, click the flyout arrow in the Gradient blending area,
and click a blend.

Applying styles to gradients
You can apply a style to a gradient.

Linear and radial styles

You can create a linear transition from one end of a gradient to the other. You can
also create a radial sweep of a gradient, similar to a radar scope, or the motion of
hands on a clock.
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On the left, the linear style, and on the right, the
radial style

Rectangular and squared styles

You can create a rectangular gradient, in which the influence of the source image
displays in the gradient. You can also create a squared gradient, in which the
aspect ratio is symmetrical.
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On the left, the rectangular style, and on the right,
the squared style

Circular and elliptical styles

You can create a circular core-to-perimeter gradient. You can also create an
elliptical core-to-perimeter gradient, in which the shape of the ellipse is influenced
by the shape of the source image.

On the left, the circular style, and on the right, the
elliptical style
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Angular and curved shapeburst styles

You can create an angular shapeburst with sharp edges and harsh transitions, for
a crystalline look. You can also create a curved shapeburst, that gently conforms
to the source image, for a rounded look.

AR RE RN RN R N AET] (RONRNUARRB RO RN RNRRNEN]

On the left, the angular shapeburst style, and on the
right, the curved shapeburst style

Mapped styles

You can apply mapped styles that use the hue, luminance, or saturation values of
the source image to define the map point at which the gradient is shaped. Points
of minimum hue, luminance, or saturation apply most to the left side of the
gradient, and shift to the right as the value increases.

You can also use the transparency levels of the gradient to define the map point.
The point furthest to the right, where a gradient is less transparent, marks the
start of mapping.
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To apply a linear or radial style
1 Inthe Settings panel, click the flyout arrow in the Gradient style area.
2 From the Style list box, choose one of the following styles:

* Linear

+ Radial

k”’? If you are applying a radial style, you can view the gradient from
different perspectives. For more information, see “Viewing gradients
from different perspectives.”

You can also change the angle of a linear or radial gradient relative to
the source image. For more information about angling a gradient, see
“Changing gradient orientation.”

To apply a rectangular or squared style
1 Inthe Settings panel, click the flyout arrow in the Gradient style area.
2 From the Style list box, choose one of the following styles:

+ Rectangular

¢ Square
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k’f} You can view a rectangular or squared gradient from different
perspectives. For more information, see “Viewing gradients from
different perspectives.”

You can also change the angle of a rectangular or squared gradient
relative to the source image. For more information about angling a
gradient, see “Changing gradient orientation.”

To apply a circular or elliptical style
1 In the Settings panel, click the flyout arrow in the Gradient style area.
2 From the Style list box, choose one of the following styles:

+ Circular

+ Elliptical

To apply an angular or curved shapeburst style
1 In the Settings panel, click the flyout arrow in the Gradient style area.
2 From the Style list box, choose one of the following styles:

+ Shapeburst-Angular

+ Shapeburst-Curved

To apply a mapped style
1 Inthe Settings panel, click the down arrow in the Gradient style area.
2 From the Style list box, choose one of the following styles:
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¢+ Hue map

*

Luminance map

*

Saturation map

*

Selection map

Viewing gradients from different perspectives

If you have applied a circular, elliptical, radial, rectangular, or squared style to a
gradient, you can view its active layer from different perspectives.

For more information about styles, see “Applying styles to gradients.”

To view a gradient from different perspectives
1 Click the X,Y button in the Preview window.

2 Drag in the Preview window.

2y
k/ If you move a squared or rectangular gradient, the new view is also
reflected in the position of the X center and Y center sliders in the
Settings panel. As you move the active layer of a gradient with the X,Y
button, the X center and Y center sliders also move according to the
new settings.
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